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Het Zarafa Collaboration Platform (ZCP) kombineert het gebruiksgemak van Outlook met de
stabiliteit en flexibiliteit van een Linux server. ZCP komt met een uitgebreide web-interface, de Zarafa
WebAccess, en bied uitstekende integratie mogelijkheden met een brede selectie clients waaronder
de populairste mobiele telefoon platformen.

De meeste componenten van ZCP zijn open source, met de AGPLV3" licentie. Zij kunnen dus vrij
gedownload worden als ZCP's Community Edition”.

Een aantal componenten zijn niet open source, namelijk:
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» de Zarafa Windows Client die integratie met Outlook mogelijk maakt,

» de Zarafa BES Integration die samewerking met de Blackberry Enterprise Server faciliteert,

de Zarafa ADS Plugin die beheer via Active Directory vergemakkelijkt, en

de Zarafa Backup Tools.

Deze componenten zijn, samen met een aantal geavanceerde opties voor grote installaties en
hostsers, enkel verkrijgbaar in combinatie met een support contract als onderdeel van ZCP's
Commercial Editions®.

Daarnaast wordt ZCP ook als online dienst aangeboden door diverse partijen.

Dit document, de gebruikershandleiding, beschrijft hoe je ZCP moet gebruiken vanuit het oogpunt van
de gebruiker. Het handelt over:
» Outlook integratie mbv de Zarafa Windows Client,

» werken met de web-interface van de Zarafa WebAccess,
« clients die CalDAV en/of iCal ondersteunen aansluiten op ZCP, en

« synchroniseren met mobiele telefoon platformen zoals: BlackBerry, Google Android, Windows
Mobile en de Apple iPhone.
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Inleiding

Het Zarafa Colloboration Platform (ZCP) combineert de bruikbaarheid van Microsoft Outlook en
Exchange met de stabiliteit en flexibiliteit van een Linux server. Het beschikt over een rich web-
interface, de Zarafa WebAccess, en levert uitstekende integratie opties voor verschillende clients,
inclusief de meest populaire mobile platformen. De meeste componenten van de ZCP zijn open
source, gelicenseerd onder AGPLv3, en kunnen hierdoor gratis worden gedownload met de
Community Editie van ZCP.

Een aantal aanwezige componenten zijn niet "open source", namelijk:

» de Zarafa Windows Client voor integratie met Outlook,

» de Zarafa BES integratie voor verbinding met de BlackBerry Enterpise Server,

« de Zarafa ADS Plug-in waarmee met Active Directory geintegreerd kan worden, en
» de Zarafa Backup Tools.

Deze componenten, evenals geavanceerde functies voor grote installaties en hosters, zijn alleen
beschikbaar in combinatie met een support overeenkomst als onderdeel van de commerciéle edities
van het ZCP.

Als alternatief is er een brede selectie van gehoste ZCP aanbiedingen beschikbaar.

Deze gebruikershandleiding beschrijft hoe ZCP gebruikt kan worden vanuit het oogpunt van de
gebruiker.

1.1. Intentie van dit document

Deze handleiding is bedoeld voor gebruikers van het Zarafa Collaboration platform. Gebruikers
kunnen op verschillende manieren interactie hebben met dit platform:

» Microsoft Outlook en de Zarafa Windows Client
» De zZarafa WebAccess, onze open source web-based groupware oplossing, en

 Verschillende mobiele platformen zoals: BlackBerry, Google Andriod, Windows Mobile en Apple
iphone.







Werken met Zarafa WebAccess

In dit hoofdstuk beschrijven we hoe je Zarafa WebAccess, de web-gebaseerde interface van het
Zarafa Collaboration Platofrm (ZCP), moet gebruiken.

Om gebruik te maken van de Zarafa WebAccess is een redelijk recente versie van Mozilla Firefox
(aanbevolen) of Microsoft Internet Explorer nodig.

Momenteel ondersteunt de Zarafa WebAccess de meest gebruikte features van Microsoft Outlook op
een uitgebreide manier. Toch kan een op web gebaseerde interface nooit dezelfde functionaliteit en
gebruikersgemak hebben als een oorspronkelijke client (zoals Microsoft Outlook).

2.1. De basis

Om in te loggen in Zarafa WebAcces, ga met je browser naar de URL die door je systeembeheerder
werd aangegeven. Standaard ziet de URL er zo uit:

http://YOUR_DOMAIN_NAME/webaccess/

WebAccess is beschikbaar in verschillende talen. Deze kunnen geselecteerd worden in het
dialoogvenster dat u ziet op Figuur 2.1, “Zarafa's aanmeldingsscherm”.

Figuur 2.1. Zarafa's aanmeldingsscherm

Nadat je ingelogd bent, zijn alle Outlook mappen en de publieke mappen waarop je account recht
heeft beschikbaar. De meeste basisfunties zijn beschikbaar vanuit de WebAccess werkbalk. Deze vind
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je aan de bovenkant van de paina. Zie ook Figuur 2.2, “Het menu "Nieuw"".

- Opmerking

Op enkele mappen zijn sommige functies alleen beschikbaar via het contextmenu dat verschijnt
als je met de rechter muisknop op de map Kklikt.

Figuur 2.2. Het menu "Nieuw"

2.2. Mappen beheren

Aanmaken, verplaatsen, hernoemen, kopiéren of verwijderen van (sub)mappen gebeurt door een
rechtermuisklik in de mappenlijst. Hierdoor verschijnt een contextmenu zoals in Figuur 2.3, “Het
contextmenu van een map”.

Figuur 2.3. Het contextmenu van een map

Het is niet mogelijk om de standaard mappen van Outlook (zoals Inbox, Calendar en Contacts) te
verwijderen, verplaatsen of te hernoemen.

2.2.1. Afdrukken

Het is mogelijk om berichten, afspraken en contactpersonen vanuit WebAcces af te drukken. Gebruik
de Afdrukken knop in de gereedschappenbalk.

Als je deze stappen volgt, is het ook mogelijk om kalender overzichten voor een dag, een week of een
maand af te drukken.
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2.2.2. Kaders aanpassen

Net als in Outlook is het mogelijk om de kaders van WebAcccess te wijzigen. Zo krijg je volledige
controle of de breedte en hoogte van de werkruimte van elke kader. Om dat te doen zet je de muis
tussen twee kaders en sleep je de kaderrand naar de gewenste plaats.

2.2.3. De map verwijderde items leeg maken

De map Verwijderde items kan leeggemaakt worden door met de rechtermuisknop op de map te
klikken en in het contextmenu te kiezen voor Map leegmaken. Deze optie is enkel beschikbaar vanuit
het contextmenu (via de rechtermuisknop) van de map Verwijderde items en de map Junk E-mail (als
deze bestaat).

2.2.4. Items herstellen

When deleting an item in the Deleted Items folder or the Junk Email folder, the item is still temporarily
recoverable. Select the Deleted Items folder or Junk Email folder, and use the button Restore Item in
the bar at the top. As shown in Figuur 2.4, “Het venster "Herstel een item™” it is possible to restore all
or a selection of the deleted messages or folders. The restored items will be moved to the old location.
Deleting items from Figuur 2.4, “Het venster "Herstel een item™” removes them permanently —in that
case only backups can recover an item. When restoring a folder, only that folder will be restored. If the
restored folder contained subfolders, these can be restored by selecting the just restored folder and
clicking on the Restore Item button again.

Figuur 2.4. Het venster "Herstel een item"

2.2.5. Alle berichten in een map markeren als gelezen

Je kan alle berichten in een map als "gelezen" markeren door met de rechtermuisknop de menu-
optie Alles markeren als gelezen te klikken. Denk er wel aan dat er geen leesbevestigingen worden
verstuurd, ook als is die optie geselecteerd bij de instellingen.

2.2.6. Eigenschappen

De optie Eigenschappen in het contextmenu geeft bijkomende informatie over een map. Het betreft
de grootte van de map en het aantal items in die map. Voor meer details over grootte van de map
gebruik je de knop Map grootte. Je ziet dan een lijst met de alle submappen in die folder met voor elke
submap de grootte ervan.

2.3. Toegang tot mappen en kalenders van andere
gebruikers

Net zoals in Outlook, laat WebAccess toe om mappen te delen. Om dat te doen klik je met de
rechtermuisknop op een map en kies je voor Eigenschappen. Selecteer dan de tab Machtigingen
zoals getoond in Figuur 2.5, “Machtigingen op mappen”.

Figuur 2.5. Machtigingen op mappen

2.3.1. Een persoon toevoegen
Klik bij Eigenschappen onder het tabblad Machtigingenop de knop Toevoegen.




Machtigingen aanpassen

Wanneer het Adresboek tevoorschijn komt, selecteer je de persoon die je machtiging wil geven en klik
op Ok. Deze contactpersoon zal dan toegevoegd worden aan de lijst met Machtigingen.

' Opmerking

Hou er AUB rekening mee dat de rechten van deze persoon moeten gewijzigd worden.
Standaard worden geen extra rechten toegekend.

Klik Ok om te bewaren en het venster Eigenschappen te sluiten.

2.3.2. Machtigingen aanpassen
Klik op de persoon voor wie je de machtigingen wil wijzigen.

Nu kunnen de rechten handmatig ingesteld worden onderaan het venster met de rechten. Je kan ook
een van de voorgedefinieerde profielen selecteren van het dropdown meny Profielen.

Klik Ok om te bewaren en het venster Eigenschappen te sluiten.

2.3.3. Een persoon verwijderern
* Klik in de lijst op de persoon die verwijderd moet worden.

* Klik op knop Verwijderen.

» Klik Ok om te bewaren en het venster Eigenschappen te sluiten.

2.3.4. Gedeelde mappen openen

Om in Zarafa's WebAccess een gedeelde map te openen, klik op Open gedeelde map, onderaan
de mappenlijst. Een venster zoals u kan zien in Figuur 2.6, “Gedeelde mappen openen” zal getoond
worden.

Figuur 2.6. Gedeelde mappen openen

In het venster getoond in Figuur 2.6, “Gedeelde mappen openen” is het mogelijk om ofwel een enkele
map (bijvoorbeeld de map Kalender) ofwel de hele mappenlijst van een gebruiker te openen.

De geopende mappen worden opgeslagen in het Webaccess profiel van de gebruikers. De volgende
keer wanneer de gebruiker aanmeldt op WebAccess zijn de geopende mappen reeds beschikbaar.

Om een geopende map te sluiten, gebruik je de optie Map sluiten optie in het context menu dat je
krijgt via een klik met de rechtermuisknop.

2.4. E-mail

2.4.1. Nieuwe E-mail opstellen en verzenden

1. Selecteer de knop Nieuw in de linker bovenhoek. Er zal dan een venster zoals dit Figuur 2.7, “E-
mail aanmaken” verschijnen.

Figuur 2.7. E-mail aanmaken
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2. Bijlagen kunnen aan een E-mail toegevoegd worden door de knop Bijlage of op het ikoon
Paperclip te klikken.

3. E-mail kan bewaard worden door op het ikoon Schijf te klikken. Nadat een E-mail bewaard is,
wordt hij opgeslagen in de map Concepten.

4. Om een vlag te zetten die aangeeft of een E-mail belangrijk is of hoge prioriteit heeft, klikt u op het
ikoon met het Uitroepteken ().

5. Om een bestemmeling toe te voegen kan u het e-mail adres in het veld aan, CC, of BCC typen of
je kan een persoon uit het Adresboek kiezen. Om naar het Adresboek te gaan, klik je op de aan,
CC, of BCC knop.

' Opmerking

Als je meer dan een bestemmeling toevoegd, moet je de adressen scheiden met een
kommapunt (;).

6. Standaard worden de interne gebruikers getoond in het Adresboek, tenzij je dit anders instelt bij
Instellingen (zie: Figuur 2.8, “Adresboek”). Door gebruik te maken van het Namen weergeven
uit: drop-down menu is het mogelijk om contactpersonen te zien uit de map met persoonlijke
contactpersonen of van een map met publieke contactpersonen. Daarenboven is het mogelijk om
in een map te zoeken via het zoekveld in linkerbovenhoek van het venster.

Figuur 2.8. Adresboek

' Opmerking

Sinds versie 6.30.0 is het mogelijk om algemene adressen toe te voegen aan het Adresboek.
Lees voor meer details over deze adreslijst de ZCP Administrator Manual.

2.4.1.1. Automatische e-mail adres suggestie

Wanneer je een e-mail adres of gegevens van een contactpersoon typt in het veld aan, CC of BCC
zal WebAccess automatisch namen suggerern (een optie gekend als auto complete). De suggesties
worden weergegeven onder het invoerveld (zie: Figuur 2.9, “Automatische suggesties”) en een
suggestie kan je selecteren met de muis of met het toetsenbord. De suggesties zijn gebaseerd op
email addressen en contactpersonen die recent gebruikt werden.

Het is mogelijk om een Adres van deze lijst te verwijderen door het bedoelde adres te selecteren
(door ofwel er met de pijltjestoetsten naar toe te gaan of door de muisaanwijze erover te plaatsen) en
dan op de toets Delete te duwen. Het adres wordt dan verwijderd, maar wanneer het adres opnieuw
gebruikt wordt, zal het terug in de lijst opgenomen worden.

Figuur 2.9. Automatische suggesties

2.4.1.2. Bijlagen

Je kan bestanden aan je bericht toevoegen door op de knop Bijlagen te klikken in het venster E-Mail
maken. Er zal een nieuw venster geopend worden waarin je bestanden kan uploaden.
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Nieuwe E-mail opstellen en verzenden

Vanaf ZCP 6.50 is het mogelijk om meerdere bijlagen tegelijk te uploaden. Vorige versies van ZCP
laten enkel het uploaden van een bestand per keer toe.

. Opmerking

Om meerdere bestanden tegelijk te uploaden moet Adobe Flash in de browser geinstalleerd zijn.

2.4.1.3. Kies het afzender adres (Van field)

Het is mogelijk om het Van addres van e-mails in te stellen alvorens ze te verzenden. Dit veld vind je
boven het Aan veld. Dit wordt getoond in het venster Figuur 2.10, “Een afzendadres selecteren”.Als er
geen adres geselecteerd wordt, wordt het standaard adres gebruikt.

Figuur 2.10. Een afzendadres selecteren

Opmerking

Weet wel dat het Van veld enkel getoond wordt wanneer er Van addressen werden toegevoegd
bij Instellingen.

Figuur 2.11. Afzender adressen toevoegen

Belangrijk

Contacteer je systeem administrator wanneer je de volgende boodschap krijgt bij het versturen
van e-mails met een ander afzender adres:U heeft geen rechten om als deze gebruiker e-mail te
versturen.

Vanaf ZCP versie 6.20.0 zijn er twee types van delegeren mogelijk:

1. De toelatingen voor Versturen als: wanneer een gebruiker de juiste rechten toekent aan een
andere gebruiker, dan kan deze laatste e-mails versturen als de andere gebruiker. In dit geval zal
een e-mail of een vergaderverzoek verzonden worden met het volgende Van veld: “<delegate> als
<user>".

2. Verzenden als rechten: als de systeembeheerder de juiste rechten toekent aan gebruiker B om te
'verzenden als' gebruiker A, zal de ontvanger van een e-mail niet zien dat gebruiker B de e-mail
verzonden heeft. De ontvanger zal enkel gebruiker A in het veld Van zien.

Voor ZCP versie 6.20.0 hadden gebruikers zelf de mogelijkheid om 'verzenden als' in te stellen door
de inbox van een andere gebruiker te gebruiken. Hierdoor was het altijd zichtbaar wie de e-mail
verstuuder. Bijvoorbeeld: Pete gebruikt de inbox 'info' en verstuurd een e-mail als de niet-actieve
gebruiker 'info'. Dit zal als resultaat hebben:

pete@example.com als info@example.com.

Since ZCP version 6.20.0 it is possible to send emails as other users without the “on behalf of”
part. Due to security reasons the new “send as” permission is only configurable server-side by 7
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the administrator. This setting can always be overruled by the user itself and the old “on behalf of”
permission can still be set by the user.

Keep in mind that delegation always overrules impersonation. A user can always choose not to let
another user impersonate as himself.

2.4.1.4. Een email opslaan als concepten

Om een email op te slaan moet je op het Opslaan icoon (een diskette) drukken. Na de email te
hebben opgeslagen, wordt deze bewaard in de Concepten map. Een andere optie is om automatisch
een niet verstuurde email op te slagen. Deze optie is in te schakelen onder de tab Bericht opstellen

bij de instellingen. Om dit te doen, controleer de optie Automatisch niet verzonden berichten opslaan
na X minuten en vul in om de hoeveel minuten je automatisch wilt opslaan. Dit is enkel mogelijk als de
email nog niet verstuurd is.

2.4.2. Inline images

From ZCP version 6.30.0 the WebAccess has the ability to add inline images in mail messages. To
add an inline image, click on Attachments and select an image. If the ‘HTML' format is being used (see
Compose mail in this format in Settings, Compose mail tab), the inline image functionality is enabled.
A light blue cross icon will appear beside the attachment as seen in Figuur 2.12, “Light blue cross icon
to insert the image as a inline image”. Click on the blue cross icon to insert the image in the mail body
as shown in Figuur 2.13, “Example of an Inline Image”. The inline image will inserted at the last cursor
position.

Figuur 2.12. Light blue cross icon to insert the image as a inline image

Figuur 2.13. Example of an Inline Image

Om de grootte van de afbeelding te wijzigen, klik rechts op de afbeelding en ga naar Afbeelding
eigenschappen. Een popup zoals Figuur 2.14, “De afbeelding eigenschappen bewerken” zal
verschijnen zodat de gebruiker de lengte en breedte van de afbeelding kan aanpassen en opties krijgt
om de rand en uitlijning te veranderen.

Figuur 2.14. De afbeelding eigenschappen bewerken

It is possible to delete the inline image directly from the main body, as if it were text.

In some browsers it is possible to paste an image from your clipboard directly into the editor. This
will embed the image into the source of the body and it means that it will not become an attachment.
The image will be shown properly in Firefox and Internet Explorer 9, with limited support in Internet
Explorer 8. In Outlook the image will not be visible properly.

2.4.3. Kopieer, verplaats en verwijder een email

The following screenshot (Figuur 2.15, “Context menu from a mail message”) shows the context menu
that shows up when clicking with the right mouse button on an email. Through this menu most copy,
move and delete operations are performed. It also is possible to download a message as a file.

Figuur 2.15. Context menu from a mail message

2.4.3.1. Verwijder email
Er zijn verschillende manieren om een email te verwijderen. Deze zijn:




Kopieer, verplaats en verwijder een email

* Via de verwijder knop op het toetsenbord

* Via de verwijder knop in het menu dat je te zien krijgt met een rechter muisklik (zoals hiernaast
getoond Figuur 2.15, “Context menu from a mail message”)

» Via de knop met het rode kruis dat je terugvindt in de bovenste lijn van webaccess

2.4.3.2. Verplaats email

Om 1 enkel item te verplaatsen is de meest gemakkelijke oplossing om het te verslepen naar zijn
nieuwe locatie. Plaats de cursor het item dat je wilt verplaatsen, klik erop en hou de linker muisknop
ingedrukt. Blijf deze ingedrukt houden tot je de cursor verplaatst hebt naar de map waar je het bericht
wilt plaatsen.

Figuur 2.16. Verplaatsen van een email

Merk op dat de naam van de mappen onder je cursor oplichten bij beweging van je cursor. De folder
die oplicht toont aan waar je het bericht zal plaatsen als je de linker muisknop loslaat.

Om meerdere items te verplaatsen, moet je eerste alle items die je wilt verplaatsen selecteren (alleen
items die zichtbaar zijn op dat moment kan je verplaatsen). Om een hele reeks items te selecteren klik
je op het eerste item en dan houd je de shift toets op je toetsenbord ingedrukt. Voor je de shift toets
loslaat, klik je met de cursor op het laatste item van de reeks die je wilt verplaatsen. Alle items die zich
hier tussen bevinden zullen mee oplichten.

Voor items die zich niet allemaal onder elkaar bevinden, houd de Ctrl knop ingedrukt op het
toetsenbord terwijl je op elk te verplaatsen item klikt. Om deze items te verplaatsen, laat de Ctrl knop
los, plaats de cursor naar 1 van de geselecteerde items, en sleep ze naar de gewenste folder.

Items kunnen ook verplaatst worden door te klikken op de kopieer/verplaats knop zoals het voorbeeld
in Figuur 2.17, “Kopieer/Verplaats knop”.

Het is ook mogelijk om berichten te verplaatsen naar het bureaublad. Voor meer info over deze
mogelijkheid, zie Paragraaf 2.14.1, “Zarafa Attachment Drag ‘n’ Drop Extension”.

2.4.3.3. Kopieer email

To copy an item, the drag-and-drop feature can not be used as it does not duplicate items. Instead use
the copy/move button as shown in Figuur 2.17, “Kopieer/Verplaats knop”. See the section above about
moving multiple items for an explanation concerning how to select multiple items.

Figuur 2.17. Kopieer/Verplaats knop

2.4.3.4. Een email opslaan als bestand

Vanaf ZCP 6.50, is het mogelijk om berichten onmiddelijk van de Zafara WebAccess te downloaden
naar je computer. De Email opslaan als bestand knop in de berichten menu, als in voorbeeld
Figuur 2.18, “Save Email as a File button”, zorgt hiervoor.

Figuur 2.18. Save Email as a File button
2.4.3.5. Change email view

Figuur 2.19. Context menu form a mail view column
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In the Zarafa WebAccess, the email view has a default layout: a list of messages with a From and a
Received colomn. However, like in Outlook, it is possible to change the view by adding or removing
columns. To do so, use the right mouse button to click on the header of the list (for example on the
From header field) and select the Field Chooser option from the context menu. A dialog that looks like
Figuur 2.20, “Field Chooser” will pop up.

Figuur 2.20. Field Chooser

Het is mogelijk om de email lijst te sorteren door te klikken op een kolom. Standaard zijn de emails
gesorteerd op de Ontvangen datum kolom.

2.4.4. Zoeken

Om te zoeken klik op de Zoeken knop in de werkbalk. Een zoekbalk (zie: Figuur 2.21, “Zoek opties”)
zal toegevoegd worden aan WebAccess (voor het verwijderen van de zoekbalk, druk de Zoeken knop
opnieuw in).

Figuur 2.21. Zoek opties

The seach bar allow a user to enter a search query and choose where to search. For example if a user
remembers just a part of a message’s subject he can select Subject from the pull down menu. After
the query is keyed in the user should click the Search button (binoculars icon) on the seach bar, or
press the enter on the keyboard. As shown in Figuur 2.22, “Zoek resultaat”, the email list is updated
with the results of the search query.

Figuur 2.22. Zoek resultaat

Op het einde van het zoeken druk de Wissen knop (rode cirkel) in om terug te gaan naar het normale
uitzicht van WebAccess. Om de zoekbalk te verwijderen klik opnieuw op de Zoeken knop.

' Opmerking

Archiving functionality is provided by the Zarafa Archiver, a product that is be offered separately
from ZCP.

2.4.5. Bijlagen downloaden

Bijlagen downloaden kan één per één, door een rechter muisklik op de bijlage en de Opslaan als
knop in te drukken. Vanaf ZCP 6.50, is het mogelijk om alle bijlagen van een bericht in 1 keer te
downloaden, in een ZIP bestand, door te klikken op de Download bijlagen knop, zie: Figuur 2.23,
“Bijlagen in een bericht”.

Figuur 2.23. Bijlagen in een bericht

2.4.6. Bijlage invoegen in email
Om bijlage toe te voegen of door te sturen als tekstbericht in de email

1. Klik op de ltems toevoegen knop of de envelop met paperclip icoon (zie: Figuur 2.24, “Attach Item
Dialog”).

Figuur 2.24. Attach Item Dialog

10



Gebruik van de kalender

Opmerking

It's possible to quickly forward e-mail messages as attachments. Right-click the Forward
Items column in the message list.

2. Blader door de berichtenlijst en selcteer de items die ingevoegd moeten worden.

Figuur 2.25. Nieuwe email met berichten toegevoegd als bijlage

Opmerking

Items kunnen toegevoegd worden als tekst of als bijlage. Door het selectievakje aan te
vinken zoals vereist, standaard, worden items toegevoegd als bijlage.

' Opmerking

Items kunnen snel toegevoegd worden door dubbel te klikken op de geselecteerde items.

Belangrijk

Bijlagen van de originele email worden niet meegezonden met het nieuwe bericht.

2.5. Gebruik van de kalender

2.5.1. Maak nieuwe afspraken met uithodigingen en aanwezig/

afwezig status.
1. Selecteer de kalender

2. Selecteer de knop Nieuw voor het maken van een nieuwe afspraak. Er verschijnt een
dialoogvenster zoals in Figuur 2.26, “Nieuwe afspraak”.

Figuur 2.26. Nieuwe afspraak
3. Voeg een onderwerp toe voor de afspraak, en optioneel een locatie.
4. Selecteer een begin en einduur voor de afspraak.

5. Optional: Enable the reminder option, this will trigger a reminder pop-up (see: Figuur 2.27,
“Reminder dialog”) before the appointment starts. The time interval between the reminder and the
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10.

to pop-up, the Zarafa WebAccess shows a list of these reminders with buttons to Open the item,
Dismiss the item, Dismiss All items or to Snooze the reminders by a given time.

' Opmerking

Pop-ups moeten toegestaan zijn door de browser voor het zien van herinnering pop-ups.
Vaak heeft de browser de domeinnaam van Zafara WebAccess nodig voor deze pop-ups toe
te staan.

Figuur 2.27. Reminder dialog

Using the button Invite Attendees one can send a meeting request as shown in Figuur 2.28,
“Afspraak verzoeken”. To add attendees, simply add their email addresses. The email addresses
need to be separated by a semicolon. By clicking the To: button contacts can be selected from the
Address Book. The attendee will receive a meeting request which the attendee can Accept, accept
as Tentative or Decline, alternatively the attendee can also Propose New Time for that request.

Figuur 2.28. Afspraak verzoeken

Bij het openen van de tab Agenda, de aanwezig/afwezig tijden van meerdere mensen worden
getoond (zie: Figuur 2.29, “Agenda/VrijBezet”). Op deze tab kunnen collega's uitgenodigd worden
(Voeg naam toe); je krijgt een overzicht dat je weergeeft of een specifieke persoon bezig is,

niet aanwezig op kantoor, of beschikbaar is. Als een genodigde een nieuwe datum of tijd heeft
voorgesteld voor een afspraak, de voorstellen worden getoond in de Agenda tab.

Figuur 2.29. Agenda/VrijBezet

Figuur 2.30. Afspraak verzoeken
Collega's kunnen toegevoegd worden via het Voeg naam toe veld.

Attendees can be marked either as “required” or as “optional”. It is also possible to schedule a
resource — like a room or a piece of equipment — needed for that meeting.

' Opmerking

Resources moeten gecreéerd worden door de administrator.

In de tab Tracking een lijst van alle genodigde voor deze afspraak, met hun antwoord, worden
getoond.

Figuur 2.31. Tracking tab

12



Acepteer een uitnodiging

2.5.2. Acepteer een uitnodiging

Als iemand je uitnodigt voor een afspraak, zul je een uitnodiging ontvangen. Bovenaan de uitnodiging
verschijnt een balk met de knoppen Accepteer, Voorlopig bezet, Weiger en Stel nieuwe tijd voor voor
het versturen van een antwoord naar de afzender. Zie Figuur 2.32, “Meeting invitation buttons”.

Figuur 2.32. Meeting invitation buttons

Door te klikken Stel nieuwe tijd voor een gebruiker kan dan een nieuwe datum of tijdstip voorstellen
aan de afzender. De afzender, ontvangt het voorstel, en kan dit accepteren of weigeren.

2.6. Multiple calendar views

De Zafara WebAccess kalender heeft 5 verschillende uitzichten:
* per dag
* per werkweek

e per week

per 7 dagen (zoals per werkweek, maar met 7 dagen)
» per maand

Je kan wisselen van uitzicht via de 4 knoppen in de werkbalk.

De datumkiezer wordt gebruikt om te veranderen van dag/week/maand, welk je kan vinden bovenaan
rechts van je scherm waar de kalender geopend is.

2.6.1. Verplaats/verwijder afspraak

2.6.1.1. Verplaats afspraak

Een afsrpaak kan verplaatst worden naar een andere datum/tijd door het item te selecteren en het te
verslepen naar een andere datum of tijd. Alternatief, (als de nieuwe datum bijvoorbeeld niet op het
huidige scherm staat) een afspraak kan geopend worden (zelfs door er dubbel op te klikken of door
rechts te klikken en te kiezen voor de Open optie), dit opent een venster waar men een nieuwe datum
of tijd kan invullen.

2.6.1.2. Verwijder afspraak

Afspraken kunnen verwijderd worden door de verwijder knop in de tab die verschijnt wanneer je rechts
klikt op een afspraak Alternatief, je kan de Verwijder knop gebruiken in de werkbalk, of de Del/Delete
knop op je toetsenbord.

2.7. Multi User Kalender

Meerdere gebruikers kunnen gelijktijdig de Multi User kalender gebruiken (zie Figuur 2.33, “Multi User
Kalender™): klik op de Open Multi User kalender link onderaan van het kader.

13
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' Opmerking

Deze functie is niet beschikbaar in deze versie van Zafara.

Figuur 2.33. Multi User Kalender

2.7.1. Toevoegen van een gebruiker aan de tijdslijn.

1. Klik op de Gebruiker toevoegen knop in de werkbalk bovenaan (zie: Figuur 2.34, “Tijdslijn”). Het
adresboek zal openen.

Figuur 2.34. Tijdslijn
2. Kilik op de gebruiker voor deze te selecteren en klik op de knop Ok.

3. De gebruiker is toegevoegd aan de tijdslijn en zijn/haar afspraken worden geladen.

2.7.2. Verwijder een gebruiker van de tijdslijn

Selecteer een gebruiker door te klikken op het selectievakje voor hun naam. Klik op de knop Verwijder
gebruiker in de werkbalk bovenaan.

2.7.3. Toevoegen van een groep gebruikers aan de tijdslijn

1. Kilik op de knop Groep Laden... in de balk bovenaan. Het "Groepsvenster", zoals in Figuur 2.35,
“User groups”, zal openen.

Figuur 2.35. User groups
2. Selecteer een groep in het linkergedeelte van de lijst en klik op de knop Ok.

3. De groep van gebruikers is toegevoegd aan de tijdslijn en hun afspraken zullen geladen worden
per gebruiker.

2.7.4. Load group dialog

The Load Group dialog can be opened by clicking on the button Load Group in the bar at at the top.

The dialog consists of two lists. The list to the left shows the different groups that have been created.
The list to the right displays all the users that are members of a particular group when that group has
been selected from the left list.

Voor het toevoegen of verwijderen van een groep of gebruiker klik op de plus of min knop aan
de rechterkant van de lijst. Denk eraan dat een groep vooraf moet geselecteerd worden voor het
toevoegen of verwijderen van een gebruiker.

2.7.5. No Access message

When using the Multi User Calendar with several calendars of collegues open, one might not have
permission to create appointments for a colleague, or not have permission to view the content a
colleague’s calendar at all. In case one does not have permission to create an appointment for a

14



Cumulative free/busy information

colleage, an icon is placed after the colleague’s name as an indicator. In case one has no access to
the calendar at all, the entire time line for that user is marked red and a warning message appears as
shown in Figuur 2.36, “No Access message”.

Figuur 2.36. No Access message

2.7.6. Cumulative free/busy information

The row directly above the time lines (see: Figuur 2.37, “Vrij of bezet informatie voor alle genodigde”)
contains the cumulative free/busy information of all users loaded in the Multi User Calendar. The bar
also shows whether the appointments are set as Tentative, Busy or Out of Office.

Figuur 2.37. Vrij of bezet informatie voor alle genodigde

2.7.7. Maak of verwijder een afspraak

Om een afspraak te maken moet je dubbel klikken op de tijdslijn of de gebruiker waarvoor een
afspraak gemaakt moet worden. Er zal een nieuw afspaken venster openen waar een afspraak
gemaakt kan worden.

Voor het verwijderen van een afspraak: dubbel klik op de afspraak voor deze te openen, druk
vervolgens op de knop met het rode kruis is de werkbalk van de afspraak om deze te verwijderen.

2.7.8. Afspraken verplaatsen

Het verplaatsen van een afspraak kan gebeuren door het openen van de starttijd. In praktijk zullen
meer gebruikers voorkeur geven aan het verplaatsen van afspraken via drag-and-drop. Voor het
verslepen van een afspraak moet de gebruiker op de linker muisknop klikken en de afspraak
verplaatsen via de tijdslijn naar de gewenste datum. Voor het vergemakkelijken van het verplaatsen
van afspraken een rode overlay (zie: Figuur 2.38, “Verslepen van afspraken”) zal de muis volgen om
de nieuwe plaats van de afspraak aan te wijzen.

Figuur 2.38. Verslepen van afspraken

Het is ook mogelijk om een afspraak te verslepen naar de store van een andere gebruiker (mits
voldoende rechten zijn toegekend). Verplaats de muis naar een andere gebruikersrij en de rode
overlay zal volgen.

2.7.9. Verander het zoomniveau

It is possible to quickly zoom in on the time line by changing the zoom level using the drop down menu
(see: Figuur 2.39, “Zoomlevel”) in the top left corner of the Multi User Calendar. This setting is not
saved and will be reset to the default setting (as set in the settings dialog) next time the Multi User
Calendar is opened.

Figuur 2.39. Zoomlevel

2.7.10. Verander het aantal weergegeven dagen

Het aantal dagen dat geladen zijn in de tijdslijn en het aantal dagen dat zichtbaar zijn tegelijkertijd
(zoomlevel) kan veranderd worden via het instellingenvenster: op de Kalender tab in de Multi User
Kalender uitzicht sectie.

15
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2.7.11. Bladeren naar een bepaalde periode

The Previous Period and Next Period buttons on the tool bar at the top of the page (see: Figuur 2.40,
“Knoppen voor de tijd te veranderen”) are used to view the next of the previous time line period. The
Previous Day and Next Day buttons merely move the time line by a single day.

Figuur 2.40. Knoppen voor de tijd te veranderen

2.8. Taken

In de taken map kan er een to-do lijst gemaakt en beheerd worden. Een taak wordt gemaakt in de
volgende stappen:

1. Selecteer de map Taken

2. Gebruik de knop Nieuw voor het maken van een nieuwe taak. Een Nieuw taak venster wordt
geopend zoals getoond in Figuur 2.41, “Nieuwe taak venster”.

Figuur 2.41. Nieuwe taak venster

3. Vul de gewenste velden in. De velden in het venster zijn vergelijkbaar met de velden in het
Nieuwe afspraakt venster.

4. Gebruik de Opslaan knop om te bevestigen. De taak kan nu gevonden worden in het taken
overzicht.

Alternatively, new tasks can be created directly from the Tasks overview (see: Figuur 2.42, “Taken
overzicht”). Right below the tool bar the fields for creating a new task as shown. Simply enter the field
for a new task directly into these empty field and save it with the ENTER key.

Figuur 2.42. Taken overzicht

2.8.1. Herhaling in taken

Figuur 2.43. Taken herhaling

2.8.1.1. Toevoegen/Veranderen van herhaling in taken
Alleen de eigenaar van een taak kan deze veranderen in een tijdelijke taak.

7

1. Selecteer Herhaling van het menu in het taken venster zoals inFiguur 2.41, “Nieuwe taak venster”.
Er verschijnt een herhalings venster zoals in Figuur 2.43, “Taken herhaling”.

2. Select the frequency (Daily, Weekly, Monthly, Yearly) of recurrence.
3. Om aan te geven wanneer een taak herhaald wordt, doe een van de volgende:

* Repeat the task at regular intervals: Click on options given on the right-side of Recurrence
pattern to recur the task on specific intervals

« Herhaal taken op intervallen na de datum waarop het is voltooid Klik Regenereren Nieuwe
taak en vul het interval in in het vakje.
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Takenverzoek

Opmerking

Recurring tasks appear one at a time in the task list. When user marks one occurrence of the
task complete, the next occurrence appears in the list.

2.8.1.2. Remove Recurrence from a Task
1. Open de terugkerende taak

2. KlikRecurrence van het menu in het taken venster.

3. KlikVerwijder herhalingen zoals in Figuur 2.43, “Taken herhaling”

2.8.2. Takenverzoek

Naast het maken van taken voor zichzelf, kan een gebruiker taken zenden naar andere via een
taakverzoek.

Figuur 2.44. Taakverzoek

2.8.2.1. Een taak toewijzen aan iemand

1. Klik Taak toewijzen uit het menu van het taken venster zoals in Figuur 2.41, “Nieuwe taak
venster”. Dit laat velden zien voor een taakverzoek zoals in Figuur 2.44, “Taakverzoek”.

2. Voer een gebruikersadres in in hetAan veld. Het gebruikersadres kan ook ingevuld worden door te
klikken op Bekijk namen knop in de menu of van de Suggestielijst die open springt wanneer je een
naam intikt.

3. Select or clear the Keep an updated copy of this task on my task list check box and the Send me a
status report when this task is complete check box.

4. Typ instructies of informatie over de taken in de body.

5. KIlik Verstuur

' Opmerking

If a recurring task is assigned, a copy of task is created in task list but it won't be updated. If
Send me a status report when this task is complete check box is selected, a status report will be
received for each completed occurrence of the task.

2.8.2.2. Accepteren of weigeren van een taakverzoek
1. Open de taak of het taakverzoek.

2. Klik Accepteren of Weigeren.

2.8.2.3. Terugeisen van de eigendom van een geweigerde taak
1. Open de taak die de weigering van het taakverzoek bevat

2. KiIik Terug naar takenlijst
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2.9. Contactpersonen
De Contactpersonen map heeft verschillende uitzichten: kaartweergave en lijstweergave. Wisselen
tussen de uitzichten gebeurd met de knoppen in de werkbalk.

Emails can be send directly to contacts by the right mouse button context menu option Email
Message.

De letters aan de rechterzijde van het contactoverzicht maakt het de gebruikers makkelijk om snel en
eenvoudig door de contactlijst te gaan.

Figuur 2.45. Contactpersonen

2.9.1. Maak een nieuw contact

Een nieuw contact wordt gemaakt met de Nieuw knop in de werkbalk, wanner je de Contactpersonen
map bekijkt.

Het Nieuwe contactpersoon venster wordt dan getoond zodat de gebruiker vervolgens de informatie
over deze persoon kan ingeven voor hij het kan opslaan mer de Opslaan knop.

Met de optie Privé, in de rechter benedenhoek van het Nieuwe contactpersoon venster, De
nieuwe contactpersoon kan verborgen worden voor de collega's die ook toegang hebben tot deze
Contactpersonen map.

2.9.2. Gedetailleerde contactpersonen

Sinds ZCP versie 6.30 de WebAccess biedt je een gedetailleerd venster van contactpersonen zoals in
Figuur 2.46, “Details van een contactpersoon”.

Figuur 2.46. Details van een contactpersoon

In het contactpersonen venster, zijn er knoppen beschikbaar ipv labels; klik op een knop voor de
details van dat specifieke veld. Screenshots voor de gedetailleerde vensters voor Volledige naam
(Figuur 2.47, “Name details dialog”), Telefoonnummer (Figuur 2.48, “Phone details dialog”) en Adres
(Figuur 2.49, "Address details dialog”) worden hieronder getoond.

Figuur 2.47. Name details dialog
Figuur 2.48. Phone details dialog

Figuur 2.49. Address details dialog

Er zijn 3 soorten adresvelden (Thuis, Werk en Andere). De tab zoals in Figuur 2.50, “Cascade menu
to choose the address type” wordt gebruikt om te wisselen tussen deze adressen. In dit menu, tekens
naast de adrestypes geven weer welke adressen al zijn ingevuld.

Figuur 2.50. Cascade menu to choose the address type

Vreschillende types van Telefoonnummer velden zijn beschikbaar in het Zafara WebAccess. Om het
Telefoonnummer type te wijzigen, gebruik de menu zoals in Figuur 2.51, “Cascade menu to choose
the phone type”. In dit menu, tekens naast de adrestypes geven aan welke telefoonummertypes al zijn
ingevuld.
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Distributielijst

Figuur 2.51. Cascade menu to choose the phone type

2.10. Distributielijst

Een email versturen naar een distributielijst wordt gedaan op dezelfde manier als een email versturen
naar 1 contactpersoon. Selecteer de distributielijst van de adreslijst wanneer je iets toevoegt aan Aan,
CC of BCC veld. Nadat je de distributielijst hebt geselecteerd, alle emailadressen zullen geplaatst
worden in het hoofdveld.

2.10.1. Maak een nieuwe distributielijst
Selecteer de Contactpersonen map waarin de distributielijst is in opgeslagen. Selecteer de optie

Distributielijst van de Nieuw knop in de werkbalk. Een venster zoals in Figuur 2.52, “Nieuwe
distributielijst venster” verschijnt.

Figuur 2.52. Nieuwe distributielijst venster

Met de knop Selecteer leden kunnen contactpersonen geselecteerd worden van het Adresboek voor
toe te voegen aan de distributielijst. Alternatief, de Nieuw toevoegen knop kan gebruikt worden voor
het maken van een nieuw contact dat onmiddelijk wordt toegevoegd aan de distributielijst.

Figuur 2.53. Add new address dialog

Met de knop Verwijderen kunnen geselecteerde contactpersonen verwijderd worden van de
distributielijst. Contactpersonen worden geselecteerd door te klikken op het onderste deel van het
venster.

Notities kunnen ook toegevoegd worden aan de distributielijst met de Notities tab.

2.11. Public Folder Favourites

The Favourite folder, located under the Public Folders, is a place where shortcuts to often used public
folders can be stored. To add a public folder to the favourites, right click on that public folder and select
Add to favourite folder. A dialog as shown in Figuur 2.54, “Toevoegen aan favorieten venster” will
appear. It asks: “Fill in a name for the favourite folder (by default the same name will be given to the
folder)”. By default only the selected folder will be inserted in the favourite folder without subfolders
(unless specified otherwise).

Figuur 2.54. Toevoegen aan favorieten venster

2.12. Regels

Rules automatically perform actions on incoming messages based on certain criteria, they can move,
copy, delete or forward the message. When a message is deliverd the rules are applied directly on the
Zarafa Server, so a user does not have to be logged in to execute the rules.

Voor het maken of bewerken van de regels, open eerst het Regels venster door te klikken op de
Regels knop in de werkbalk (zie: Figuur 2.55, “Regels knop”). Deze knop kan alleen gezien worden
wanneer een emailmap is geopend.

Figuur 2.55. Regels knop
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A dialog as shown in Figuur 2.56, “Rules overview dialog” is presented. In this dialog a user’s rules
can be created, modified or deleted. It is also possible to change the order in which the rules are
applied. To change the order of a rule select it and click the Up or Down button.

Voor het uitschakelen van de regels zonder deze te verwijderen, klik het selectievakje aan dat staat
voor de regel. Alleen aangevinkte regels zullen uitgevoerd worden wanneer er een nieuwe email
binnenkomt. Na het aanvinken of afvinken van de regels, klik op de Ok knop voor de veranderingen te
bewaren op de server.

Figuur 2.56. Rules overview dialog

Om een nieuwe regel te maken, klik op de Nieuw knop in het Regels venster. Het venster zoals in
Figuur 2.57, “Toevoegen/bewerken van het regelsvenster” wordt getoond. Dit is het zelfde venster
als dat voor het bewerken van regels dat wordt geopend door een regel te selecteren van het Regels
venster en te klikken op de Bewerk knop.

Figuur 2.57. Toevoegen/bewerken van het regelsvenster

In the Rule name field a short description of the rule —to identify it in the rules overview dialog — can
be provided. Below the Rule name field the criteria of the rule are specified. The incoming message
can be matched by sender address, by subject, by the priority it has, by the recipient address, or
based on if the message has “only been sent to me”. These criteria can be combined to match
messages more specifically. The buttons behind the input fields to open the Address Book to select an
email address.

* Belangrijk

All the criteria filled in must be fulfilled in order for an email to be seen as matching the rule.

Terwijl het mogelijk is om de *Zenden naar* Contactpersoon of Distributielijst en de Alleen naar
mij zenden criteria te combineren, kunnen ze in tegenspraak zijn met elkaar waardoor een regel
nutteloos is.

Tot slot moet de actie worden uitgekozen. Dit spreekt voor zichzelf. Wanneer de instellingen van de
Verplaats of Kopieer actie, de bestemmingsfolder moet worden opgegeven door te klikken op de
onderstreepte tekst.

Wanneer u klaar bent moet u het venster sluiten door te klikken op de Ok knop. Om de regel op te
slaan, het Regels venster moet gesloten zijn wanneer u klikt op Ok.

2.13. Instellingen

In de rechter benedenhoek van de Zafara WebAccess, aan de linkerkant van de Uitloggen link, staat
een link waarmee het Instellingen venster geopend kan worden. Het Instellingen venster bevat 6 tabs,
de volgende secties bevatten elk een tab.

2.13.1. De "Voorkeuren" tab

Figuur 2.58. Instellingen: Voorkeuren

» Taal, zet de standaard taal voor WebAccess.
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De "Opstellen mail" tab

Kleur thema, kies een van de volgende Zilver, Wit en de default (blauw).

Automatisch afmelden, gebruik deze optie om de veiligheid te verhogen en stel de WebAccess in
zodat deze automatisch afmeldt als deze voor een bepaalde tijd niet wordt gebruikt.

Opstarten map, de map die verschijnt als je je aanmeldt op Webaccess.
Aantal weergegeven items per pagina.

Reading pane visible, if and where the preview pane for emails should be located. Pick one of Right,
Bottom or Off.

Nieuwe mail controle , standaard zal WebAccess elke 5 minuten kijken voor een nieuwe email.
Hoe te reageren op verzoeken tot leesrechten, kies 1 van de opties.

Edit Delegates..., opens a dialog for choosing which users are allowed to be the current user’s
delegates. Delegates are allowed open the current user’s store, and send messages --emails or
(responses on) meeting requests-- on his behalf.

Resultaten verversen elke (X) seconden, hoe vaak de resultaten van geavanceerde zoekopdrachten
moeten worden vernieuwd.

2.13.2. De "Opstellen mail" tab

Figuur 2.59. Opstellen malil

Antwoord adres, het adres waarop de ontvanger van de email zal antwoorden wanneer hij klikt op
"Antwoorden".

Compose mail in this format, composing new mails as Plain text or HTML (rich formatting).

Close original message on reply or forward, when double clicking a mail in the list view a dialog
pops up showing the message. With this option enabled that dialog will close when either its reply or
its forward is clicked.

Vraag altijd om een leesbevestiging, zet deze op automatisch verzoek leesbevestigingen.
AutoSave unsent every: ... minutes, set when to auto-save unsent messages.

Cursorpositie bij beantwoorden, waar de cursor moet beginnen voor het invoeren van tekst bij de
beantwoording een e-mail.

Set FROM email addresses, here the addresses that can be used to send mail FROM are specified.
Use the ‘+’ button on the right to add an address; to remove an address select it and click the ‘-’
button. While composing an email the FROM address can be selected from a drop down menu on
top of the TO field — this drop down menu contains the addresses picked with this setting.

Figuur 2.60. Voorbeeld: instellen van adres

Opstellen handtekeningen ... , open het handtekeningvenster waar de handtekeningen -- van
nieuwe emails of beantwoorde en latere emails -- worden beheerd. Zie Figuur 2.61, “HTML
handtekening”.

Figuur 2.61. HTML handtekening
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2.13.3. De "Niet aanwezig" tab

Een gebruiker kan zichzelf zetten als "in" of "uit" het kantoor. Een AutoReply bericht wordt automatisch
verstuurd als antwoord op alle inkomende berichten en dit bericht kan ingevuld worden op dit tabblad.

Voor overvolle mailboxen te vermijden, worden AutoReplies maar 1 keer per dag verstuurd naar
hetzelfde emailadres.

2.13.4. De "Kalender" tab

 Start en Einde van werkdag, specificeert het deel van de dag dat is gemarkeerd als "werkdag".

» Verticale grootte, de verticale afmeting van de kalender. Mensen met een zeer grote display willen
overwegen de instellingen te veranderen in Groot.

» Kalender resolutie, de kleinste tijdblok waarmee afspraken overeen komen.

» Default Reminder, wheather or not reminders are added to appointments by default, and if so,
how long before the appointment start the default reminder should occur. These setting can be
overwritten per appointment.

De volgende opties hebben betrekking op de Multi User Kalender (MUK):

» Aantal getoonde dagen, het aantal dagen die zichtbaar zijn op het standaard zoomniveau van de
MUK.

» Aantal geladen dagen, het aantal dagen die worden geladen. Wanneer dit aantal groter wordt dan
de Aantal getoonde dagen, moet je scrollen om de resterende dagen te zien.

2.13.5. De "Adresboek" tab

» Standaard geselecteerde map/adresboek, stelt in welke map van het adresboek standaard moet
gebruikt worden in het Zarafa WebAccess.

2.13.6. De "Snelkoppelingen” tab

De toetsenbord sneltoetsen kunnen ofwel "aan" of "uit" staan. Alle beschikbare sneltoetsen worden
hier vermeld.

2.14. Firefox Extensies

Since the Zarafa WebAccess is web application, it cannot deliver all functionality a native application
can. Especially integration with the desktop is hard for web applications. To overcome this Zarafa
has released two extensions for Mozilla Firefox", since most of our clients use this fully open source
browser.

De huidige Zarafa biedt 2 Firefox extensies van hun website:

2.14.1. Zarafa Attachment Drag ‘n’ Drop Extension

By installing this plug-in it is possible to use drag-and-drop for files in order to attach them to
messages. It is possible to drag and drop a single file or a selection of multiple files.

! http://mozilla.org
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Zarafa Nieuwe Mail Informatie Extensie

From 6.40.4 up, this plug-in also allows messages to be dragged and dropped to the desktop. This
function is used by selecting one or more messages and then dragging and dropping the envelope-
icon to your desktop, as seen in Figuur 2.62, “Sleep berichten pictogrammen naar het bureaublad”.

' Opmerking

From 6.40.5 up, the add-on is no longer included in the ZCP packages, and can only be installed
from the Mozilla FireFox add-ons site located at https.//addons.mozilla.org/en-US/firefox/addon/
zarafa-dragndrop/

Figuur 2.62. Sleep berichten pictogrammen naar het bureaublad

2.14.2. Zarafa Nieuwe Mail Informatie Extensie

De zZafara Nieuwe Mail Informatie Extensie laat gebruikers toe om hun Zarafa inbox te controleren
zonder Zarafa WebAccess of Outlook. Een Zafara icoon wordt in de rechter benedenhoek van de
Firfox browser getoond en informeert de gebruikers over binnenkomende mail. Door te dubbel klikken
op het icoon worden de gebruikers omgeleid naar hun WebAccess.

2.14.2.1. Instellingen

Met een rechter klik op het Zafara icoon zijn de uitbreidings instellingen beschikbaar, zoals in
Figuur 2.63, “Zarafa Mail-checker extension settings”.

Figuur 2.63. Zarafa Mail-checker extension settings
Het is mogelijk om de plug-in te activeren of te deactiveren.
Het is noodzakelijk om de url van Zarafa WebAccess en de gebruikers naam in te vullen.

Met de geavanceerde instellingen kan de gebruiker de plug-in personaliseren door het veranderen
van het tijdsinterval voor e-mail controle en het inschakelen/uitschakelen van de melding van nieuwe
mail. Het is ook mogelijk om aan te geven hoe de Zarafa WebAccess moet worden geopend wanneer
je dubbel klikt op het Zarafa icoon, en inschakelen of uitschakelen van het automatisch inloggen op
WebAccess.

2.15. Gevorderde Zarafa WebAccess configuraties

2.15.1. Zarafa WebAccess als standaard mailclient

Sinds ZCP versie 6.20 is het mogelijk om de Zarafa WebAccess in te stellen als standaard mailclient.
Hieronder tonen we drie voorbeelden on associating de WebAccess met de standaard actie voor
wanneer een gebruiker klikt op een e-mail adressenlink.

2.15.2. Vensters

Voor alle gebruikers op een computer:

Windows Registry Editor Version 5.00
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[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client]
@="Zarafa Web Client"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols]

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto]
"URL Protocol"=""

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell]
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open]
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open
\command]

@="rundl132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\shell]

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\zZarafa Web Client\shell\open]
@="ZzZarafa Web Client"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open\command]
@="rundl132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto]

"EditFlags"=hex:02, 00,00, 00

"URL Protocol"=""

@="URL:MailTo Protocol"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell]
[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell\open]
[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell\open\command]

@="rund1132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

Alleen voor actuele gebruikers:

Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client]
@="Zarafa Web Client"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto]
"URL Protocol"=""

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"
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Linux

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell]
[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open]
[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open
\command]

@="rundl132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open]
@="Zarafa Web Client"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\zZarafa Web Client\shell\open\command]
@="rundl132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

[HKEY_CURRENT_USER\Software\Classes\mailto]

"EditFlags'"=hex:02,00, 00,00

"URL Protocol"=""

@="URL:MailTo Protocol"

[HKEY_CURRENT_USER\Software\Classes\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_CURRENT_USER\Software\Classes\mailto\shell]
[HKEY_CURRENT_USER\Software\Classes\mailto\shell\open]
[HKEY_CURRENT_USER\Software\Classes\mailto\shell\open\command]

@="rundl132.exe url.dll,FileProtocolHandler http://<ZARAFA_WEBACCESS_ADDRESS>/index.php?
action=mailto&to=%1"

2.15.2.1. Installeren van de ".reg" bestanden
1. Open een tekstverwerker zoals kladblok.

2. Insert the desired registry key, where <ZARAFA_WEBACCESS_ADDRESS> should be replaced by
the url of your Zarafa WebAccess.

3. Inthe Start Menu, hit Run, enter regedit, and hit Ok.
4. Importeer de zojuist aangemaakte registersleutel.

5. In Outlook 2003/2007 go to Tools > Options > Other > uncheck Make Outlook the default program
for Email, Contacts & Calendar.

6. Inthe Start Menu, hit Run, enter %windir%, and hit Ok. The default Windows folder will be
opened.

7. Kopieer en plak zarafa.ico in de map. Het icoon kan worden gevonden op de server in de
volgende map: /webaccess/client/layout/img/favicon.ico.

2.15.3. Linux

1. Maak een nieuw script bestand mailto. sh.

2. Zetde volgende regels in een bestand:

#!/bin/bash
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ADDRESS="echo $1|cut -f 2 -d : -~

# Logs this to syslog... just helps to make sure it is working properly
logger "Opening Zarafa mail client, addressed to $ADDRESS"

firefox "http://<SERVER>/<USER>/webaccess/index.php?action=mailto&to=$ADDRESS"

3. Replace http://<SERVER>/<USER>/webaccess/ with base URL of the WebAccess.

4. Sla het bestand op (bij voorkeur in de home directory), laat dan chmod uog+rwx mailto.sh
van dezelfde directory lopen.

5. Now type gnome-default-applications-properties on a console or go to System >
Preferences > More Preferences > Preferred Applications.

6. Open “Mail reader” and set it to a custom action that looks like: /home/<USERNAME>/
mailto.sh %s

2.15.4. Voeg Zarafa WebAccesss toe als mailto handler in Firefox
Bij het klikken op een URL van een e-mailadres (a mailto address) in Firefox zal proberen om een
e-mailclient te openen. Firefox heeft een lijst van mogelijke mailclients, met de mogelijkheid om een
standaard te kiezen. Voor het gebruik van de Zarafa WebAccess te hanteren mailto via URL's in
Firefox volg de stappen:

1. Typ about:config in de adresbalk en druk Enter. Negeer de garantie waarschuwing.
2. Zetgecko.handlerservice in de filterbox.

3. Double-click gecko.handlerService.allowRegisterFromDifferentHost. This will
change its value from false to true.

4. Paste this code in the address bar while replacing https://<ZARAFA_WEBACCESS_ADDRESS>
with the URL used to access the installation of the Zarafa WebAccess (usually the url used to get
to the login screen of the WebAccess), then press Enter:

javascript:window.navigator.registerProtocolHandler("mailto", "https://
<ZARAFA_WEBACCESS_ADDRESS>?action=mailto&url=%s", "Zarafa WebAccess")

5. Onder de adresbalk vraagt een bericht of de Zarafa WebAccess moet worden toegevoegd als een
verzoek om de mailto links te behandelen. Klik op de Applicatie toevoegen knop.

6. Next time mailto: link is clicked, a screen will appear allowing the preferred mail client to be picked.
Select the Zarafa WebAccess, and possibly check the box next to Remember my choice for
mailto: links, then click OK.

Vanaf nu zal de Zarafa WebAccess onmiddelijk in werking treden wanneer je klikt op “mailto” links in
Firefox. Merk op dat een gebruiker moet ingelogd zijn (of gebruik maken van Single Sign On) zodat
het goed werkt.

2.16. Quirks

2.16.1. Firefox specific

Since Firefox 4.0, some alert messages may popup from the main window instead of in the message
dialog. Although the alert message can handled in the other window, it may be confusing why
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Firefox specific

the browser isn't responding. To revert the alert message behaviour to separate windows, the
Firefox configuration needs to be altered. To do this, open a new tab or window in Firefox and type
about :config in the url bar. Filter on prompts to find the correct option. Change the value of

prompts.tab_model_enabled from true to false. Alert popups will now be separate windows
again.
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Separate WebApp manual

' Opmerking

Zarafa WebApp has moved to its own WebApp User Manual* and is no longer part of the general
User Manual.

! http://doc.zarafa.com/trunk/User_Manual_WebApp/en-US/html-single/
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Outlook configureren (met de Zarafa
Windows Client)

4.1. Installatie van de Outlook client

There are two requirements that must be fulfilled prior to installing a Zarafa workspace. First, Outlook
2003 or higher is needed, and second, the user must be created on the Zarafa Server.

De volgende stappen zijn benodigd om de Zarafa werkruimte te installeren:

- Opmerking

Het is aan te raden om de meest recente Service Packs en Beveiligingspatches te installeren.

4.1.1. de Client installeren

Om de Zarafa Windows Client te installeren, zorg je ervoor dat Outlook ingesteld is als standaard
toepassing voor e-mail. Dat doe je via Configuratiescherm > Internet > Toepassingen. Steek de Zarafa
CD in de CD/DVD drive en wacht op het automatisch starten van de CD. Kies de bovenste optie:
Windows Client. Wanneer je de Zarafa Windows Client van een andere bron downloadde, dubbelklik
het bestand zarafaclient .msi.

' Opmerking

Samen met versie 5.10 introduceert Zarafa een MSI installatiebestand voor de Zarafe client in de
plaats van een .exe bestand. Wanneer er een upgrade vanaf een versie lager dan 5.10 gedaan
wordt, adviseren we om de oude Zarafa client eerst te verwijderen alvorens het nieuwe MSI
installatiebestand te laten lopen. De vorige versie niet verwijderen kan tot gevolg hebben dat er
twee Zarafa clients zichtbaar zijn in de lijst met software van uw Windows PC.

- Opmerking

De Zarafa client 5.xx kan niet werken met versie 6.xx van de Zarafa server. Met de Zarafa Client
versie 6.xx zal er tijdens de installatie gevraagd worden of de bestaande bestanden geuipdatet
moeten worden. Kies voor deze optie indien er geen verbinding met een 5.xx server (meer) nodig
is.

4.1.1.1. Instructions for Outlook 2003.

Create a new mail profile in Outlook 2003:

1. Go to Control Panel > Mail > Show Profiles....

2. Klik Toevoegen... en geef een titel in, bij voorbeeld Zarafa. Klik OK.
Add a Zarafa Server to this profile:

1. Choose Create a new mail account and click Next in the dialog window that appears after adding
the profile (or after choosing Email Accounts... in Outlook or the Mail setup). 31
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8.

Choose the last option (Extra server types) and click Next > choose Zarafa 6 Server > click Next.
The window shown on the right will appear.

Fill in the address or host name of the server in the Server field.

Optionally: choose HTTPS connections where available.

Fill in the login data of the user in the Username and Password fields.

Choose the connection type, there are 3 different possibilities:

* Online

» Cached Zarafa mode

» Detecteren bij opstarten

- Opmerking

Meer informatie over de drie connectie types kan gevonden worden in Paragraaf 4.2,
“Outlook connection type”.

Selecteer OK enkele keren om het venster te sluiten.

4.1.1.2. Instructions for Outlook 2007 and higher

1.

2.

3.

9.

Go to Control Panel > Mail > Show Profiles...

Click on Add... and fill in a title, for example Zarafa. Click OK.

Select the option Manually configure server settings or additional server types and click on Next.
Select Other, and choose Zarafa Server and click Next.

Fill in the address or host name of the server in the Server field.

Optioneel: selecteer HTTPS verbindingen indien beschikbaar.

Vul de inlog gegevens van de gebruiker in de Gebruiker en Wachtwoord velden.

Click Ok. The personal folders of this user and the public folders will appear as store in Outlook
after adding the server in this way.

Click Finish to finalise the profile.

* Belangrijk

The Zarafa account has to be the default account in the Outlook profile. It's not possible to have
the Zarafa account as secondary account and use as primary account for example an IMAP
account.
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4.1.2. Start Outlook

1. Start Outlook and make sure the added profile is being used.
2. This can be set in Control panel > Mail > Profiles... on the bottom of the dialog window.

3. The private mailbox of the entered user and the public folder will appear as a store in Outlook.

4.2. Outlook connection type

By default, Outlook has an ongoing connection to the Zarafa server and does not store the folders
and items on the local hard drive. With the introduction of Zarafa 6.00, it is possible to synchronise all
private Outlook data to the local hard drive. Email, agenda and contacts can easily be accessed even
if no connection to the server is available. This functionality is only available if the offline storage is
enabled (see the connection types below).

The following three options are available for the connection to the server: Online, Detect at startup and
Cached zZarafa mode. These will be described in the sections below.

4.2.1. Online

The Online type works the same as in the previous versions of Zarafa. When a network connection to
the server is available, Outlook can be started. Whenever the connection to the server is not available
email, agenda and contacts can not be accessed.

4.2.2. Detect at startup

With the Autodetect Offline / Online type Outlook checks at startup if the server can be reached. When
Outlook has a connection to the Zarafa server all items will be synchronised to the offline storage.
When the connection is lost, Outlook will not automatically switch to its offline storage. In order to
switch to offline storage, Outlook needs to be restarted.

When Outlook is started and there is not a network connection available, Outlook will show a pop-up
message which asks if it is wanted to work offline.

- Opmerking

Whenever the “_Detect at startup_" mode decides to work offline, the behaviour for that
session will be as described below in Paragraaf 4.2.3, “Cached Zarafa Mode”, effectively. In
case it decides to work online, the behaviour of that session will be as described above in
Paragraaf 4.2.1, “Online”.

4.2.3. Cached Zarafa Mode

The third type of connection is Cached Zarafa Mode. This type is similar to the caching mode of MS
Exchange. If this type is selected, the offline storage will always be used. When there is a network
connection available all items of the user's own store will be synchronised to the offline storage. The
first time the Outlook profile is being configured it is required to have a connection to the Zarafa server.
After the profile is created and Outlook can be started, all folders and items will be synchronised.
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* Belangrijk

Please consider the limitations of the use of offline storage as described in Paragraaf 5.1.2,
“Limitations of working offline”.

4.2.4. What is the best connection type to choose?

Tabel 4.1. Verbinding type opties
Type gebruiker Zarafa profiel type

User that always works on the same fixed PC in the office Online

User that uses roaming profiles and logs in on different fixed PC’'s in | Online
the office

User that works with a fixed PC remote from a sub department over a | Cached Zarafa Mode
small bandwidth internet connection

User with a laptop that is inside the office most of the time Detect at startup
User with a laptop that is always out of the office Cached Zarafa Mode
User that works on a Terminal Server Online

* Belangrijk

The Zarafa client is not designed to allow switching between the different connection types. If a
user should be able to work with an online and cached connection it is recommended to create
two separate profiles.

4.3. Geavanceerde configuratie

Since version 6.20 two new settings are introduced in order to improve connection to the Zarafa
server.

Figuur 4.1. Connection settings

4.3.1. Proxy settings

If the zarafa server is only reachable via a proxy server it is possible to enter the information of the
proxy server into the client settings.

4.3.2. Other connection settings
Two other connection settings are configurable:

Compression: Uncheck this option if compression is not wanted. This option is on by default.

Server connection timeout: Depending on the connection quality it is possible to change the timeout
to the zarafa server. Default is 30 seconds.

4.4. Favoriete publieke mappen

To have a useful shortcut to the most used public folders use the Favourite folder that can be found
under the public folders tree. In order to add a folder to the Favourite folder, right click on a public
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folder and select Add to Zarafa favourite folder. In Outlook 2007 the Add to Favourites window will
appear. In Outlook 2003 the shortcut will be added directly in the favourites folder.

By default only the selected folder will be inserted in the favourite folder — without its subfolders. It is
necessary to specify otherwise.

Figuur 4.2. Add to favorites window (Office 2007)
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De zZarafa Windows Client veranderd niet significant de manier van werken met Outlook, echter zijn
er wel extra mogelijkheden beschikbaar indien de Outlook met de Client verbonden is met de Zarafa
server.

5.1. offline werken

Nadat Outlook in de Cached Zarafa mode of Detect at startup mode is gestart, zijn de synchronisatie
onderdelen in beschikbaar. Bijvoorbeeld: De Synchronise knop in de werkbalk, dat de voortgang van
de synchronisatie laat zien.

Figuur 5.1. synchronisatie plugin knoppen

Met de configuratie knop kan de synchronisatietijd ingesteld worden.
When synchronisation is started for the first time, the Global Address Book will be synchronysed first.

After the Global Address Book has been synchronised, the Inbox will be synchronised. The most
recent emails will be synchronised first.

During the initial synchronisation new email will not be received. New email will be retrieved after the
first synchronisation is finished or after Outlook is restarted during the sync. Sending new email during
synchronisation, however, will be done immediately.

5.1.1. E-mail verzenden tijdens offline gebruik

When email is sent during offline use, the email will be kept in the Outbox. To send the email when the
connection to the server has been reinstated, the Send & Receive button has to be selected.

This action can be scheduled by configuring the Send & Receive settings:
Figuur 5.2. verzenden en Ontvangen instellingen

5.1.2. Limitations of working offline
Things to consider when using “Offline” functionality:

« Currently it is not possible to synchronise the favourite folders of the Public Folder or delegate
mailboxes.

» Public Folders and delegate mailboxes will be directly opened from the server, like the Online Zarafa
modus, and are thus not available while working offline.

e The synchronisation of a mailbox of 1000MB will take around 1 hour whith a 100Mb/s network
connection to the Zarafa server.

« In Offline mode it is not possible to open shared mailboxes or set security permissions on folders.
* In de Cached modus is de knop Open other user’s folder niet aanwezig.

» Currently, shared mailboxes and calendars can only be opened via the button Open shared folders
or via the button Open a shared calendar in the calendar section of Outlook.

« Ifit's not possible to open the Public Folder after being offline, the session is not available on the
server. To open the Public Folder again, it is necessary to restart Outlook to set up a new session.
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5.2. mappenbeheer

5.2.1. het aanmaken van een Public folder

standaard kunnen alle gebruikers mappen en items aanmaken in de public folder. Echter, de
machtigingen van deze nieuwe items zijn zo ingesteld dat deze alleen gelezen kunnen worden door
andere gebruikers.

To enable others to write to the folder, the correct permissions must be set; for example allow writing
and deleting by the group Everyone. (See Sharing of folders).

5.2.2. Mappen delen (machtigingen instellen)

De rechtenstructuur is gebouwd met flexabiliteit in het achterhoofd. Het is mogelijk om per map
machtigingen in te stellen. ledere map neemt de rechten van de bovenliggende map over. Daarnaast
neemt elk item de machtigingen over van de map waar het item in zit.

Voordat een map toegevoegd en bekeken kan worden door andere gebruikers, moeten de rechten
eerst correct worden ingesteld.

Om dit te bewerkstelligen, klik op de rechtermuisknop op een map en kies voor Eigenschappen.
Figuur 5.3. map eigenschappen knop

Figuur 5.4. Set folder permissions

In the appearing dialog window different settings can be chosen, regarding the properties of the folder.
The last tab window contains the permissions settings.

Bovenaan is een lijst met gebruikers en de bijbehorende ingestelde machtigingen die ingesteld zijn.
Nadat een gebruiker is geselecteerd, kunnen de machtigingen onderaan geselecteerd worden.

Gebruikers kunnen toegevoegd en verwijderd worden met de twee knoppen onderaan de
gebruikersilijst.

For example, to give user Pete the rights to read and write to items in a folder, first click Add.... After
selecting Pete and clicking OK, Pete will show up in the list. After this the right checkboxes can be set;
to enable reading and writing only set Read items and Edit items on All.

Tabel 5.1. Uitleg van machtigingen

Machtigingen Beschrijving

Items aanmaken De gebruiker kan items aanmaken

items lezen De gebruiker kan items lezen

Alle items wijzigen De gebruiker kan alle items wijzigen

Wijzig eigen items De gebruiker kan alleen zijn/haar eigen items
wijzigen

Verwijder alle items De gebruiker kan alle items verwijderen

Verwijder eigen items De gebruiker kan alleen zijn/haar eigen items
verwijderen

subfolders aanmaken De gebruiker kan subfolders aanmaken

Mappen zijn zichtbaar De gebruiker kan de map bekijken
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Machtigingen Beschrijving
map machtigingen De gebruiker kan machtingen op de map
veranderen

If there are no check boxes selected for a user, then denying permissions are in effect and the user
can not access the folder. When no permissions are set on the folder, the folder one level higher is
checked for the set ACLs.

' Opmerking

Permissions that apply to the user are cumulative, meaning that the user will receive the sum of
the permissions that apply to his or her user account and groups of which the user is a member.

By default a user only has read/write permissions on their own folders and is able to create folders in
the Public Folders.

The owner is saved with every item. This way, depending on the set permissions, a user is only
allowed to delete their own items and not items belonging to other users. The owner of the mail box
can always edit or delete all items in his/her mail box, regardless of the owner of the items.

It is possible to give administrative rights to users, after which they have access to the entire Zarafa
system. These administrators have the ability to change the permissions on public folders and the
folders of each user on the system. Also, every folder or item can be opened by an administrator.

5.2.3. Adding or opening folders shared by other users

To add shared folders of other users and to be able to write to or read from it, the following steps
should be executed:

1. Click in Outlook on File and Open Shared Folders....

Figuur 5.5. File menu

2. Choose in the dialog window the user and the type of folder to be opened, then click OK.

Figuur 5.6. User and folder selection

If Inbox is chosen (permanent), then not only a folder will be opened but an extra mail box will be
added in the folder list of Outlook. This folder will appear in a separate Outlook window with the folders
described as (temporary).

It is only possible to read or write to this folder after the owner has given the rights to do so. See the
previous paragraph about setting permissions.

5.2.4. Adding or removing complete stores of other Zarafa users

In order to delete mail boxes (also called stores) which were added to the list of mail boxes in the
folder list of Outlook, the user must do the following:

1. Click with the right mouse button on a mail box:

Figuur 5.7. Folder Properties selection
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2. Select Properties > click Advanced... > select the tab Advanced in the Zarafa server dialog
window.

Figuur 5.8. Zarafa server dialog
3. Click Remove to remove or Add to add a mail box.

After clicking Add, select a user to add his/her store and let the store appear in the folder list of
Outlook.

5.3. Searching in Outlook

A search executed in Outlook will query the database of zarafa-search (zarafa-indexer in Zarafa
6.40.x - 7.0.x). To enhance the search results Outlook will divide certain words in individual tokens,
depending on the language set in the language bar of Windows.

For example: searching for the word Sauermann or Dauermann in a German system. These words will
be split into mann and Sauer/Dauer. In a Dutch system the name Timmermans will be split to mans
and Timmer.

To only search for the whole word the search-term has to be endorsed in angle brackets ( < and >).

' Opmerking

The same accounts for hyphenated words like part-time. Searching for this will give all results
matching either part or time. Only searching for <part-time> will give only results matching both
words.

5.4. Restoring deleted items

Because Zarafa uses a so-called Soft Delete system, items removed from view in Outlook can still be
restored. This can be done by selecting Tools > Recover Deleted Items.

Figuur 5.9. Recovering deleted items

Select the items which need to be recovered and click on the Restore button to restore the items to the
folder they were deleted from. Most items will be restored to the Deleted Iltems folder.

If Delete is selected, the items will be truly removed from the server, and these items can no longer
be recovered. The server has a lifetime on these items, so after a set period of time, the items will be
removed.

5.5. Free/Busy updates

When new appointments are created in the calendar, the Zarafa client will update the Free/Busy
information. This update will occur some time after the appointment was saved or when Outlook is
closed. Other users will not directly see this change in their Free/Busy overview.

When an appointment is created, it is possible to invite other people. If other users are added, the
overview will be updated to show the Free/Busy times of the user, making it easy for the organizer to
plan the new appointment.
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To use the Free/Busy times, the Public Store on the Zarafa server must be available. All the Free/Busy
times will be stored in an invisible folder in the Public Store. If a user did not yet login with Outlook or
Webaccess and did not create an item in the calendar, the Free/Busy times will not be available.

5.6. Resources

With the resource feature the availibility or scheduling of meeting rooms, beamers, cars or other
objects with limited availability in the company is made easy. Resources are allocated through meeting
requests.

The following steps show how to allocate a resource:
1. Create a new appointment in Outlook.

2. Open the Scheduling tab.

Figuur 5.10. Free/Busy information
3. Add the name of the resource or select the resource from the Global Address book.

4. Change the icon Required attendee to Resource or Equipment.

Figuur 5.11. Select the option Resource
5. Add the other attendees, that will attend the meeting.
6. Select a free timeslot via the freebusy times and send the meeting to the attendees.

7. If the resource is available in this timeslot, a pop-up will show that the resource is successfully
booked.

Figuur 5.12. Pop-up after the resource is successfully booked

8. If the resource is unavailable, a different (free) timeslot needs to be selected.

- Opmerking

When an all day event is planned, please make sure the appointment is booked as Busy or Out
of Office. By default, all day events are set as free and because of that not visible in the freebusy
information.

5.7. Out of Office Assistant

1. Make sure the currently opened folder belongs to the store for which an auto-respond message
needs to be set.

2. Click in the menu of Outlook on Tools, click Out of Office Assistant.

3. In this dialog window an auto-respond message can be set and the auto-responder can be
activated or deactivated.

The first time Outlook is restarted, it will produce a pop-up asking if the auto-respond message should
be disabled again.
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This message is the same as the one that can be set with the Webaccess.

5.8. Rules

Select the Inbox folder for which a rule needs to be created, and click in the menu of Outlook on Tools
and select Rules and Alerts. Here it is possible to create rules which are processed on the server
when a new email arrives.

Figuur 5.13. Rules wizard

There are certain limits to the types of rules that can be made. The condition of the rule can be in any
form.

' Opmerking

When using Outlook 2003 or 2007, any rule created will automatically have an option called on
this machine only. This option needs to be removed so the server can execute this rule.

It is only possible to copy/move or to delete a message. These rules can be created, but they will not
be executed on the server. An example of such a rule is to send the mail to the printer, or forward it
directly to another email account.

Local rules can still be performed manually by clicking on the Run rules now button in the Rules and
Alerts dialog.

5.9. Signatures

Signatures can be set in the Options menu of Outlook. It is important to note that signatures set in
Outlook are separate from those set in the WebAccess. It is neccesary to set the signature in both
clients separately.

5.10. Signing and encrypting messages
Since Zarafa 6.10 it is possible to use S/Mime certificates. Certificates enables the use of digitally
signing emails and/or encrypting emails.

The description in this manual is the manual procedure. An automatic way to receive a certificate is to
use Active Directory Services (ADS). The automatic method is not described in the client manual, but
will be described in the server manual.

5.10.1. Retrieving a certificate

In order to get a certificate a registration at a Certificate Authority (CA) is needed. Multiple possibilities
are available; one is to have the Active Directory (AD) act as a CA, the other is to subscribe to an
independent CA, like CaCert (http://www.cacert.org/).

5.10.1.1. Certificates via AD

The company’s AD is configured to act as a CA:

1. Open Internet Explorer

2. Gotothe following URL: http://<domainserver>/servcrt. If the URL is different, ask the
systems administrator for the correct URL.
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Check encrypted email settings

3. Click on Request a certificate and on the next page on User Certificate to generate a certificate.

4. The certificate will be placed into Outlook automatically.

5.10.1.2. Certificates via an independent CA
1. Go to the site of the CA.

2. Register the email address and create a certificate.
3. Use Firefox to retrieve the certificate.

4. In Firefox, go to Tools > Options > Tab Advanced > tab Encryption > button View Certificates.

Figuur 5.14. Certificate Manager
5. Select the correct Certificate and Click Backup.
6. Enter a password.
7. Save the certificate as a PKCS12 file.
8. Open Outlook.
9. Goto Tools (if Outlook 2003: Options) > Security Tab > Click Import/Export... > Click Browse...
10. Select the correct .P12 file.
11. Enter the previous password.
12. Enter in the field Digital ID Name: the email address for which the certificate is meant.

13. Click button OK twice.

5.10.2. Check encrypted email settings

1. Go to Tools > Options > Security tab > click Settings....

2. Check if the field Security settings Name: contains the S/MIME settings for the email address.
Figuur 5.15. Security Settings

5.10.3. Using the certificate

After entering the certificate into Outlook it can be used to digitally sign outgoing emails or receive
encrypted incoming emails.

When a new email or reply is opened two new icons will be present: (the option to digitally sign
messages) and (the option to encrypt the message contents and attachments).

5.11. Fax Feature

Since version 6.20 it is possible to send fax through Outlook 2003/2007 and a third-party software
such as Hylafax.

In order to send a fax:
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1. Open the new e-mail window by clicking the File menu, selecting New and Mail Message.
2. Go to Options, Format and choose Plain Text.

3. Fillin the To: field with the following syntax [fax: <fax number>], where <fax number> is
replaced with the actual phone number of the fax machine.

4. Fillin the From: and Subject fields as they will appear in the fax cover.
5. Enter the mail body as for a normal mail message

6. Click Send

Figuur 5.16. New fax item

' Opmerking

To be able to send fax messages, an administrator needs to install software or adjust settings on
the server. Additional information for administrators can be found on the wiki article Fax server
integrationl.

5.12. Delegation

Since Zarafa 6.20 two kinds of delegation are available: Send on behalf and Send as. In earlier
versions, only Send on behalf is available.

5.12.1. Send on behalf of permissions

Send on Behalf permissions: if a user grants the appropriate permission to another user, the latter

can send items on behalf of the other user. In this case an email or meeting request will be sent
showing it was on behalf of the other user. The recipient will see in the From: field something similar to
' <delegate> on behalf of <user>_'. For example Pete enters the inbox of info and sends an email on
behalf of the non-active user info, the following would be seen:

pete@example.com on behalf of info@example.com.

The option to add delegates is available in the Options menu of Outlook, as seen in Figuur 5.17,
“Zarafa delegates”.

Figuur 5.17. Zarafa delegates

5.12.2. Send as

Send As permissions: the system administrator can grant permission to user B to send as user A. The
recipient(s) will not see that user B actually sent it; only user A appears in the From: field. See the
Administrator manual on how to grant Send As permissions to users.

Figuur 5.18. Show From: field in new email

! http://zarafa.com/wikifindex.php/Fax_server_integration
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Categorisatie

Opmerking

Due to security reasons the send as permission is only configurable by the administrator on
the Zarfa server. However, this setting can always be overruled by the user itself and the old on
behalf of permission can still be set by the user.

' Opmerking

If the (bounce) message below is returned when sending an email on behalf of, please contact
the systems administrator.

You are not allowed to send as the given user.

* Belangrijk

Due to the introduction of the Send As permissions in Zarafa 6.20 the previous abilities to send
on behalf of are reset when upgrading to version 6.20 or higher; an administrator or the user who
wants to delegate has to give the rights or permissions again.

Keep in mind that Send on Behalf permissions always overrules Send As permissions so a user
can always choose not to let another user (mis)use send as permissions.

5.13. Categorisatie

Vanaf versie 6.20 is het mogelijk om items in Outlook te categoriseren door middel van standaard
categorieén en zelf gemaakte categorieén.

5.13.1. Categorieén aanmaken in Outlook 2007

1. To create a custom category, click on the Categorise button in the Outlook toolbar and choose All

Categories.

2. The Color Categories window will appear; choose New to add a new category.

3. The New Category window will appear; fill in the name of the category, choose a color to represent
it and optionally a shortcut key.

4. Click on OK and the new category will be automatically added to the available categories in the

Color category window.

Figuur 5.19. Categorieén in Outlook 2007

Figuur 5.20. Categorieén toevoegen in Outlook 2007

5.13.2. Create a custom category in Outlook 2002/2003

1. Open een nieuwe mail en kies in de taskbar voor opties. 45
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2. Kies in dit venster (bericht opties) voor categories, en vervolgens voor Master category list.
3. Type de naam voor de nieuwe gategorie en voeg deze toe met de Toevoegen knop.

4. Nadat de categorie aangemaakt is, kan dit worden bevestigd met deOK knop in het geopende
venster.

Figuur 5.21. Add category in Oulook 2002/2003

5.13.3. Iltems categorizeren en sorteren volgens categorie.

In order to categorise an item (it is possible to categorise Mail, Contacts and Appointments) right click
on it, choose Categorise and then click on the desired category.

To order the items by category open the View menu, choose Arrange by or Current View and then
Categories.

5.14. Mail expiration date

Since ZCP version 6.20.0 it is possible to set an expiration date for the outgoing mail.

When writing a new mail, this setting can be found under Options > More Options: the Message
Options window will appear.

Tick the Expires after option and set the expiration date.

Figuur 5.22. Message options

46



E-mailprogramma configureren (met
IMAP en POP3)

6.1. client configuratie

Elke client dat IMAP4 of POP3 ondersteund, zou verbinding moeten kunnen maken met de Zarafa
IMAP & POP3 gateway.

Om mail te versturen gebruiken e-mailprogramma’s SMTP. De SMTP server kan de Zarafa server
zijn of de SMTP server van de IPS. Sommige servers hebben SMTP authenticatie nodig. Het e-
mailprogramma kan de verzonden berichten in de map Verzonden items opslaan.

' Opmerking

De aanmeldingsgegevens voor SMTP zijn niet noodzakelijk dezelfde als die van Zarafa.

* Belangrijk

Please have in mind that "/" and "." are illegal characters in foldernames in IMAP, but are
generally possible im MAPI and therefore valid in Outlook und WebAccess/WebApp. Using these
characters will lead to folders displayed with different names (for example RequestSupport
instead of Request/Support) when accessed via IMAP. Please don't use these characters when
planing to use IMAP.

6.1.1. Mozilla Thunderbird

Deze handleiding is gebaseerd op Mozilla Thunderbird versie 2. Andere webbrowsers kunnen op
vergelijkbare manier worden ingesteld.

De eerste twee stappen kunnen worden overgeslagen indien Thunderbird voor het eerst wordt
geopend. Het volgende voorbeeld is bedoeld voor het IMAP protocol. Echter, het POP3 protocol is
praktisch gezien hetzelfde, maar dan zonder stap 10 tot 12.

1. Ga naar Gereedschap> Account instellingen....

Figuur 6.1. Gereedschap dropdown menu

2. Kilik op Account Toevoegen.

3. Selecteer Email account en Kklik op Volgende.

4. Vul uw naam en Zarafa e-mail adres in en klik op Volgende.

5. Selecteer IMAP en vul de hostname of het IP address van de Zarafa server in. Klik op Volgende.

6. Vul uw Zarafa gebruikersnaam in bij inkomende gebruikersnaam en bij de uitgaande
gebruikersnaam. Klik op Volgende.

7. De account naam kan door de gebruiker zelf gekozen worden. Klik op Volgende.
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10.

11.

12.

13.

Kijk de ingevulde gegevens na en klik op Beéindigen. Sluit nu het venster Account instellingen.

Open Postvak In en geef je wachtwoord in om de mappenstructuur van de Zarafa server te
ontvangen.

Open het venster met Account instellingen opnieuw en selecteer Server instellingen in het eerder
aangemaakte account.

Stel de beveiliging in op het gewenste niveau (standaard is dit Nooit).

Selecteer Kopiéren & Mappen in de mappenstructuur van uw account en stel de juiste
mappennamen in voor de IMAP server.

Klik tenslotte op OK en Zarafa kan gebruikt worden door gebruik te maken van het IMAP protocol.

6.1.2. Windows Mail

Dit voorbeeld is gebaseerd op Windows Mail. Outlook Express van worden geconfigureerd met
ongeveer dezelfde stappen.

Het volgende voorbeeld is voor het IMAP protocol. Het POP3 protocol is praktisch gezien hetzelfde,
maar dan zonder de stappen 10 t/m 12.

1.

10.

11.

12.

13.

Ga naar Gereedschap > Account.

Figuur 6.2. Gereedschap dropdown menu

Klik op Toevoegen....

Selecteer E-mailAccount en klik daarna op Volgende.

Geef de Weergavenaam op en klik vervolgens op Volgende.
Geef het E-mail Adres in en klik op Volgende.

Selecteer in het dorpdown menu IMAP en vul hostname of IP-adres van de Zarafa server in of de
hostname of het IP-adres van de server voor uitgaande mail.

optioneel: kijk na of de uitgaande mailserver authenticatie nodig heeft en klik op Volgende.

Vul uw Zarafa gebruikersnaam in bij E-mail gebruikersnaam en het Zarafa wachtwoord. Klik op
Volgende.

Vink het vakje aan of uit bij de vraag of je al dan niet de gegevens van de server nu wil
downloaden en Klik op Einde.

Selecteer het nieuwe account in de mappenlijst en klik op Eigenschappen en het contextmenu
(dat je opent door met de rechtermuisknop op het account te klikken).

Selecteer de tab IMAP.

Kijk na of Speciale Mappen is aangevinkt en of de mappen hetzelfde zijn ingesteld als de mappen
in Zarafa.

Klik tenslotte op OK en Zarafa kan gebruikt worden door gebruik te maken van het IMAP protocol.
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Configureer kalender gebruikers (met
Caldav en iCal)

Dit hoofdstuk beschrijft hoe je de CalDAV of iCal toepassing moet configuren voor gebruik met de
Zarafa server. De zarafa-ical gateway laat gebruikers toe om hun Zarafa kalender te zien wanneer
ze gebruik maken van toepassingen zoals Sunbird, Evolution of Mac iCal. Vanaf ZCP 6.40 kunnen
taken gecreéerd en gesyncroniseerd worden mbv deze verschillende toepassingen.

Om toegang te krijgen tot de agenda mappen op de Zarafa server, zijn de volgende opties
beschikbaar.

Gebruik voor alle clients behalve de Mac OSX iCal client:

URL Agenda

http://server:8080/ical Standaard agenda van de gebruiker via iCal (niet
aanbevolen)

http://server:8080/caldav/<user>/ User’s calendar in user’s store. Make sure the

<calendar -name> calendar name is in the store.

http://server:8080/caldav/<user>/ User'’s self created subcalendar in the user’s

<subcal> own store. Location through actual subfolders in
Zarafa is irrelevant.

http://server:8080/caldav/<other - Other-user’s shared calendar

user>/<calendar-name>

http://server:8080/caldav/public/ Kalendermap in de gemeenschappelijke map

<kalendar>

http://server:8080/caldav/<user>/ User’s default calendar. Although this works for

most clients, this URL is not recommended.

Gebruik voor de Mac OS X iCal client:

URL voor de Mac OS X iCal client Agenda

http://server:8080/caldav agenda lijst van de gebruiker
http://server:8080/caldav/<andere- Agenda lijst van andere gebruikers
gebruiker>

http://server:8080/caldav/public Lijst met gemeenschappelijke mappen

The format and capabilities of iCalendar and MAPI recurrence types are very different. The conversion
of this information is not always the same, or not even possible at all at times. Following is a list of
known recurring appointment types that cause problems:

Recurrence type Description

Monthly every day of a week Convert to weekly every day of the week

Yearly every day of a week in month x Not supported
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Hoofdstuk 7. Configureer kalender gebruikers (met Caldav en iCal)

Opmerking

The <other user> or <user>/<calendar> is only reachable if the correct permissions are
available. Please make sure the user has not only the appropriate calendar permissions, but also
"Folder visible" permissions on the mailbox of the other user.

Opmerking

Mac iCal client is volledig getest en ondersteund tot versie 10.5.6.

7.1. Mac OS X iCal toepassing

1. StartiCalin Finder: klik op Go > Applications > iCal.

2. Kilik iCal in het menu en selecteer Voorkeuren.

Figuur 7.1. iCal dropdown menu

3. Klik op ‘+’ om een nieuwe account aan te maken.

Figuur 7.2. Details van het account
4. Vul verder aan. Voeg het server adres als volgt in:: http://server :8080/caldav/

5. Klik op Add om de kalender van de gebruiker op te halen.

Figuur 7.3. Account aangemaakt

7.2. Sunbird Client Handleiding

1. Start Sunbird client.
2. Kilik op Bestand in de menubalk en selecteer Nieuwe Kalendar.

3. Selecteer de optie op het Network. Klik Volgende.

Figuur 7.4. Locatie van de nieuwe kalender

4. Voor iCalendar, selecteer de iCalendar Optie. Geef als locatie in: http://server:8080/ical.

Figuur 7.5. iCal details

5. Voor caldav, selecteer de caldav Optie. Geef als locatie in: http://server:8080/caldav.

Figuur 7.6. Details voor CalDav
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Configuratie voor Evolution

7.3. Configuratie voor Evolution

1. Start de Evolution toepassing.
2. Klik op menu Nieuw. Selecteer Kalendar.

3. Vul de details & in en verwijder de Use SSL optie. De URL opties zijn vergelijkbaar in Sunbird.

Figuur 7.7. Details voor CalDav
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Configureer Mobiele Platformen

Dit hoofdstuk beschrijft hoe Z-Push software te configureren is, om PDA's en smartphones te
synchroniseren met een server gebaseerde oplossing.

Z-Push is beschikbaar als een opensource project op Sourceforge - http://z-push.sourceforge.net

8.1. Z-Push introductie

Z-Push software laat gebruikers met PDA's en smartphones hun e-mail, contacten, agenda afspraken
en taken direct synchroniseren van een ondersteunde server over UMTS, GPRS, WIFI of GSM data
verbindingen. The volgende apparaten zijn standaard ondersteund door Z-Push:

* Apple iPhone and iPad

* Windows Mobile 5, 6, 6.1 and 6.5

* Windows Phone 7 and 7.5

» Nokia E/N-series with Mail for Exchange (M4E)

* Nokia E-series with built in ActiveSync (Nokia Mail 2)

» Android Cupcake or Donut with third party tools like Nitrodesk Touchdown

» Android Eclair with Contacts and Calendar synchronization or third party tools

» Android Froyo, Gingerbread, Honeycomb, Ice Cream Sandwich and Jelly Bean using the default
ActiveSync client (Microsoft Exchange ActiveSync type account) or third party tools

» Blackberry PlayBook
 other ActiveSync compatible devices

The devices can be synchronised because the Z-Push module emulates a MS Exchange server on
the server side, allowing users to synchronise without installing specialised synchronisation software
on their devices.

8.2. Een mobiel apparaat instellen.

Configuring a device for Z-Push is simply a case of adding a Microsoft Exchange or Corporate account
to your connected accounts. The connection will be configured by specifiying the IP address or
hostname of the server running Z-Push. Please disable SSL, unless SSL has already been setup on
the Apache server. Apart from username and password some clients also ask for your domainname.
This is ignored inside of Z-Push, so you can either leave it empty or give a random string for it.

Once the mobile device has been setup, it should be possible to synchronise the device simply by
clicking the Sync button in your client application.

8.2.1. Android based configuration
The following steps are applicable for most Android devices:

1. Go into your settings screen and scroll down to the accounts part. There you have to select Add
account.
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Hoofdstuk 8. Configureer Mobiele Platformen

Figuur 8.1. Android Settings

2. Select the ActiveSync account type (in most cases Corporate or Microsoft Exchange).

Figuur 8.2. Account Type Selection

3. Android wants to autodiscover your ActiveSync server and needs your eMail and password for
this.

Figuur 8.3. Account Details

4. Afterwards you have the possibility to specify your exact username and server address if needed
(would otherwise have been m.scotfield as username and zarafa.com as server address).

Figuur 8.4. Server Address

5. As soon as you have clicked next your device will give you a popup notifying about needed
policies for the server connection. You will be prompted to accept these policies later in the setup.
Figuur 8.5. Remote Administration

6. Before accepting the sync policies you have to choose the frequency for checking the server
(Push by default) as well as what to sync (for example contacts and calendar).
Figuur 8.6. Sync Frequence and other settings

7. If you have multiple accounts connected to your device you can also specify an identifying name
for your connection.

Figuur 8.7. Optional Profile Name for the Connection

8. Finally accept the server policies.

Figuur 8.8. Accept Server Policies

9. After accepting the policies for device will perform an initial sync.

Figuur 8.9. Your device has been configured

8.2.2. Windows Mobile based configuration

De volgende stappen zijn gemaakt voor de Pocket PC, maar het is nog steeds van toepassing op WM
5/6 en Nokia's 'Mail for Exchange':

1. Open ActiveSync en selecteer Stel uw apparaat in om mee te synchroniseren.

Figuur 8.10. ActiveSync introductie
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iPhone gebaseerde configuratie

Vul het server adres in (zonder http of andere URL delen).

Figuur 8.11. Server adres

Specifeer een gebruiker en wachtwoord, een moet gespecificeerd worden maar wordt niet
gebruikt binnen Z-Push, Kies daarom domain of een ander willekeurige string tekst. Selecteer
wachtwoord opslaan als automatisch synchroniseren gewenst is.

Figuur 8.12. Account details

Selecteer de items die gesynchroniseerd moeten worden.

Figuur 8.13. Synchronisatie opties.

Klik Einde en begin met synchroniseren door op Sync te kklikken.

8.2.3. iPhone gebaseerde configuratie
De volgende stappen zijn van toepassing op de iPhone:

1.

2.

Open Instellingen en raak E-mail, Contactpersonen, Agenda aan.

Raak Account toevoegen... en Microsoft Exchange aan.

Figuur 8.14. E-mail, Contacten, Agenda instellingen

Figuur 8.15. Keuze Protocol/provider

Vul de gegevens in van de gebruiker en raak Volgende aan.

Figuur 8.16. Gebruiker instellingen

Het apparaat probeert contact te maken met de server. Als de server niet gelijk is aan
customer.com dan faalt de verbinding. Als de server niet geconfigureerd is voor SSL verbindingen
zal de verbinding ook falen. De iPhone gebruikt standaard een SSL verbinding.

Een nieuw keuzeveld Server zal verschijnen. Geef het correcte server adres of IP adres in indien
nodig.

Figuur 8.17. Extra server veld

Als SSL niet beschikbaar is kan er geen verbinding tot stand komen. Raak Opslaan aan om
de huidige account instellingen op te slaan. Ga naar het gemaakte account en raak Account
informatie aan en schakel Gebruik SSL uit.

Figuur 8.18. Instellingen opslaan

Figuur 8.19. Account instellingen
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